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Which concept did you find the most difficult in
the context of HW1 (so far if not completed)?

A.

. Output parameters

. Structs
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Dynamic memory allocation

GDB
Style considerations

. Prefer not to say



W UNIVERSITY of WASHINGTON LO8: System Call Details & Makefiles CSE333, Autumn 2025

System Call Details, Makefiles
CSE 333 Autumn 2025

Instructors: Naomi Alterman, Chris Thachuk

Teaching Assistants:

Ann Baturytski  Derek de Leuw Blake Diaz
Rishabh Jain Chendur Jel Jayavelu Lucas Kwan
Irene Xin Jie Lau Nathan Li Maya Odenheim
Advay Patil Selim Saridede Deeksha Vatwani

Angela Wu Jiexiao Xu



W UNIVERSITY of WASHINGTON LO8: System Call Details & Makefiles CSE333, Autumn 2025

Relevant Course Information

+» Homework 1 was due Thursday (10/9)
= Still possible to submit late (until Sunday @ 11:59)

«» Homework 2 rolling out soon

+ Exercise 7 due Monday (10/13)
® Qut this afternoon; practice with POSIX

+ Start using C++ on Monday!
" Many conveniences
" Many additional concerns (much larger language)
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Lecture Outline

+ System Calls (More Detailed View)
» Make and Build Tools
» Makefile Basics

+ C History (for reading, not covered in lecture)

CSE333, Autumn 2025
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System Call Analogy

+» The OS is a bank manager overseeing
safety deposit boxes in the vault

= |s the only one allowed in the vault and has the keys
to the safety deposit boxes

+ |f a client wants to access a deposit box (i.e., add or
remove items), they must request that the bank manager
do it for them
= Takes time to locate and travel to box and find the right key

= Client must wait in the lobby while the bank manager accesses
the box — prevents messing with requested box or other boxes

= Takes time to put box away, return from vault, and let client know
that request was fulfilled
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Details on x86/Linux

<+ A more accurate picture:

" Consider a typical Linux process

= |ts thread of execution can be in one
of several places:

In your program’s code

In glibc, ashared library containing
the C standard library, POSIX,
support, and more

In the Linux architecture-independent
code

In Linux x86-64 code

architecture-dependent code

Linux kernel
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Details on x86/Linux

+~ Some routines your program
invokes may be entirely handled
by glibc without involving the | ¢ standard

| )
kernel | library

" e.g. strcmp () fromstdio.h I glibc

" There is some initial overhead when
invoking functions in dynamically
linked libraries (during loading) architecture-independent code
- But after symbols are resolved,

invoking glibc routines is basically

as fast as a function call within your architecture-dependent code
program itself!

Linux kernel
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Details on x86/Linux

+» Some routines may be handled
by glibc, but they in turn
invoke Linux system calls

= e.g. POSIX wrappers around Linux
syscalls

« POSIX readdir () invokes the
underlying Linux readdir ()
= e.g. C stdio functions that read
and write from files
- fopen (), fclose (), fprintf ()

invoke underlying Linux open (),
close(),write (), etc.

CSE333, Autumn 2025

=
e I

C standard
I library

| glibc

architecture-dependent code

Linux kernel
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Details on x86/Linux

+ Your program can choose to
directly invoke Linux system calls

as well : C standard
" Nothingis forcing you to link with fibrary

glibc and use it glibc
= But relying on directly-invoked Linux
system calls may make your
program less portable across UNIX
varieties
- (And won’t be portable to non-Unix

systems like Windows that run architecture-dependent code
standard C on top of their own,
different syscalls)

Linux kernel
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Details on x86/Linux

Your program

+ Let’s walk through how a Linux
system call actually works

= We'll assume 32-bit x86 using the C standard
modern SYSENTER / SYSEXIT x86 flofieiry
instructions glibc
- x86-64 code is similar, though details
always change over time, so take this

as an example — not a debugging
guide

architecture-dependent code

Linux kernel

10
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Details on x86/Linux

OXFEFFFFFF Your program

Remember our
process address
space picture?

" Let's add some .
details: glibc

C standard
library

architecture-independent code

architecture-dependent code

Linux kernel

CPU
0x00000000 1
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Details on x86/Linux

OXFEFFFFFF Your program

Process is executing your
program code

C standard
library
SP .
glibc
architecture-independent code
architecture-dependent code
[ Linux kernel

unpriv CPU
0Ox00000000 12
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Details on x86/Linux

OXFEFFFFFF Your program

Process calls into a
glibc function

" e.g. fopen ()
= We'llignore the

messy details of SE

loading/linking glibc
shared libraries

C standard
library %

architecture-independent code

architecture-dependent code

Linux kernel

unpriv CPU
0Ox00000000 13
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glibc begins the process
of invoking a Linux system
call

Details on x86/Linux

OXFFFFFFFF

Your program

1B

glibc’s
fopen () likely
invokes Linux’s
open () system
call

C standard %

library

o glibc

Puts the system call #
and arguments into
registers

Uses the call x86

instruction to call into
the routine architecture-dependent code

__kernel vsyscall
located in 1inux-
gate.so

architecture-independent code

Linux kernel

unpriv CPU
0Ox00000000 14
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Details on x86/Linux

OXFFFFFFFF

Your program

[P
linux—-gate.soisa
vdso
= Avirtual Cslfgfacizrd %
dynamically-linked g@ .
shared glibc
object

= |s akernel-provided
shared library that is
plunked into a process’

architecture-independent code
address space

= Provides the intricate

machine code needed to
trigger a system call architecture-dependent code

Linux kernel

unpriv CPU
0Ox00000000 15
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Details on x86/Linux

linux—-gate.so
eventually invokes

OXFEFFFFFF Your program

2
I

the SYSENTER x86 o

instruction C standard

= SYSENTER is x86’s “fast Hoesy
system call” instruction glibc

Causes the CPU to raise
its privilege level

Traps into the Linux
kernel by changing the
SP, IP to a previously-
determined location

architecture-independent code

Changes some
segmentation-related

registers (see CSE451) %a rchitecture-dependent code

Linux kernel

priv CPU
0x00000000 16
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Details on x86/Linux

OxFFFFFFFF Your program
The kernel begins :
executing code at gﬁg
the SYSENTER
entry point C standard
= |sin the architecture- library
dependent part of Linux glibc

" |t'sjobis to:
Look up the system call

number in a system call %
dispatch table

« Callinto the address
stored in that table entry;
this is Linux’s system call

architecture-independent code

handler architecture-dependent code

— For open (), the
handler is named Linux kernel
sys_open,andis

system call #5 priv CPU
0x00000000 17
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Details on x86/Linux

OXFFFFFFFF

Your program

The system call
handler executes

= Whatitdoesis
system-call specific

SR
[P

C standard
library

= |t may take a long time to
execute, especially if it glibc
has to interact with
hardware
« Linux may choose to %
context switch the CPU

to a different runnable architecture-independent code
process

architecture-dependent code

Linux kernel

priv CPU
0x00000000 18
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Details on x86/Linux

OXFEFFFFFF Your program

Eventually, the

SP
system call handler
. I
finishes

= Returns back to the
system call entry point
Places the system call’s glle

return value in the
appropriate register

Calls SYSEXTIT to return
to the user-level code

C standard
library

architecture-independent code

%a rchitecture-dependent code

Linux kernel

priv CPU
0x00000000 19
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SYSEXIT transitions the
processor back to user-
mode code

Details on x86/Linux

OXFFFFFFFF

Your program

Restores the
IP, SP to

S .
user-land values glibc
Sets the CPU
back to
unprivileged mode

C standard
library %

IR

Changes some
segmentation-related
registers (see CSE451)

Returns the processor
back to glibc architecture-dependent code

architecture-independent code

Linux kernel

unpriv CPU
0Ox00000000 20
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Details on x86/Linux

OXFEFFFFFF Your program

glibc continues to

execute
= Might execute more
system calls C standard
= Eventually P library

glibc

returns back to
your program code

architecture-independent code

architecture-dependent code

> Linux kernel

CPU
0x00000000 21

unpriv
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strace

+» A useful Linux utility that shows the sequence of system
calls that a process makes:

bash$ strace 1ls 2>&1 | less

execve ("/usr/bin/1ls"™, ["1s"]1, [/* 41 vars */]) =

brk (NULL) = 0x15aa000

mmap (NULL, 4096, PROT READ|PROT WRITE, MAP PRIVATE|MAP ANONYMOUS, -1,
0x7f£03bb741000

access ("/etc/1ld.so.preload", R OK) = -1 ENOENT (No such file or directory)

open("/etc/ld.so.cache™, O RDONLY|O CLOEXEC) = 3

fstat (3, {st mode=S IFREG|0644, st size=126570, ...}) =0

mmap (NULL, 126570, PROT READ, MAP PRIVATE, 3, 0) = 0x7f£03bb722000

close (3) = 0

open("/1lib64/libselinux.so.1", O _RDONLY |O CLOEXEC) = 3

read (3, "\177ELF\2\I\I\0\N0\O\NO\NONONONONO\N3NO>\0\NI\0O\NONO\N3003\0\NO\NONONONOQ". ..,
832) = 832

fstat (3, {st mode=S IFREG|0755, st size=155744, ...}) =0

mmap (NULL, 2255216, PROT READ|PROT EXEC, MAP PRIVATE|MAP DENYWRITE, 3,
0x7f03bb2fal000

mprotect (0x7£03bb31e000, 2093056, PROT NONE) =

mmap (0x7£03bb51d000, 8192, PROT READ | PROT WRITE,
MAP PRIVATE|MAP FIXED|MAP DENYWRITE, 3, 0x23000) = 0x7£f03bb51d000

etc
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If You’re Curious

« Download the Linux kernel source code

" Available from http://www.kernel.org/

« man, section 2: Linux system calls
" man 2 1intro

" man 2 syscalls

%+ man, section 3: glibc/libc library functions

" man 3 1ntro

» The book: The Linux Programming Interface by Michael
Kerrisk (keeper of the Linux man pages)

23
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Lecture Outline

+ System Calls (High-Level View)
» Make and Build Tools
» Makefile Basics

+ C History (for reading, not covered in lecture)

CSE333, Autumn 2025
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make

+» make is a classic program for controlling what gets
(re)compiled and how

= Many other such programs exist (e.g., ant, maven, IDE “projects”)

+» make has tons of fancy features, but only two basic ideas:
1) Scripts for executing commands

2) Dependencies for avoiding unnecessary work

+ To avoid “just teaching ma ke features” (boring and
narrow), let’s focus more on the concepts...

25
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Building Software

« Programmers spend a lot of time “building”

= Creating programs from source code
= Both programs that they write and other people write

THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“MY CODE'S COMPILING.

HEY! GETBACK T
TOWORK!
|#
CONP@

https://xkcd.com/303/

26
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Building Software

« Programmers spend a lot of time “building”
= Creating programs from source code
= Both programs that they write and other people write

+» Programmers like to automate repetitive tasks
= Repetitive: gcc -Wall -g -std=c17 -o widget foo.c bar.c baz.c

- Retype this every time: @
- Use up-arrow or history: @ (still retype after logout)
- Have an alias or bash script: @

- Have a Makefile: @ (you’re ahead of us)

27
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“Real” Build Process

+» On larger projects, you can’t or don’t want to have one big (set
of) command(s) that are all run every time you change

anything. To do things “smarter,” consider:

1) It could be worse: If gcc didn’t combine steps for you, you’d need to
preprocess, compile, and link on your own (along with anything you
used to generate the Cfiles)

2) Source files could have multiple outputs (e.g., Javadoc). You may
have to type out the source file name(s) multiple times

3) You don’t want to have to document the build logic when you
distribute source code; make it relatively simple for others to build

4) You don’t want to recompile everything every time you change
something (especially if you have 10°-107 files of source code)

+ A script can handle 1-3 (use a variable for filenames for 2), but
4 is trickier

28
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Recompilation Management

+ The “theory” behind avoiding unnecessary compilation is
a dependency dag (directed, acyclic graph)

+ To create a target t, you need sources sy, Sy, ..., S, and a
command c¢ that directly or indirectly uses the sources

= |t tis newer than every source (file-modification times), assume
there is no reason to rebuild it

= Recursive building: if some source s; is itself a target for some
other sources, see if it needs to be rebuilt...

" Cycles “make no sense”!

29



W UNIVERSITY of WASHINGTON LO8: System Call Details & Makefiles CSE333, Autumn 2025

Theory Applied to C

[ foo.h ] [ foo.c ] [ bar.c ] Source files

\’\
Statically-linked [ 1ibZ.a | | fooo\( bar O ] Object files

libraries

\ 4

bar Executable

+» Compilinga .ccreatesa .o — the .o dependsonthe .c
and all included files (. h, recursively/transitively)

30



W UNIVERSITY of WASHINGTON LO8: System Call Details & Makefiles CSE333, Autumn 2025

Theory Applied to C

[ foo.h ] [ foo.c ] [ bar.c ] Source files

\’\
Statically-linked [ lin.a] L fooo\[ bar O ] Object files

libraries

A 4

bar Executable

+» Compilinga .ccreatesa .o — the .o dependsonthe .c
and all included files (. h, recursively/transitively)

+ An archive (library, . a) depends on included . o files

31
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Theory Applied to C

[ foo.h ] [ foo.c [ bar.c ] Source files

\’\
Statically-linked [ 1ibz.a | | fooo\[ bar O ] Object files

libraries

\ 4

bar Executable

+» Compilinga .c createsa .o—the .o dependsonthe .c
and all included files (. h, recursively/transitively)

+ An archive (library, . a) depends on included . o files

+» Creating an executable (“linking”) depends on . o files and
archives

= Archives linked by -L<path> -1<name>
(e.g., -L.. -1footogetlibfoo.a fromcurrentdirectory)

32
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Theory Applied to C

[ foo.h ] [ foo.c ] [ bar.c ] Source files

\’\
Statically-linked [ 1ip7z.a | | fooﬁ bar.o ] Object files
libraries | /

| bar | Executable
+ If one . c file changes, just need to recreate one . o file,
maybe a library, and re-link

« Ifa . h file changes, may need to rebuild more

+» Many more possibilities!

33
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Lecture Outline

+ System Calls (High-Level View)
» Make and Build Tools
+ Makefile Basics

+ C History (for reading, not covered in lecture)

CSE333, Autumn 2025
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make Basics

« A makefile contains a bunch of triples:
[target: sources J

«Tab—> command

" Colon after target is required
® Command lines must start with a TAB, NOT SPACES

= Multiple commands for same target are executed in order
- Can split commands over multiple lines by ending lines with “\’

+» Example: [foo.o: foo.c foo.h bar.h
gcc -Wall -o foo.o -c foo.c

35
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Using make

S make -f <makefileName> target

« Defaults:

" |f no —f specified, use a file named Makefile in current dir
" If no target specified, will use the first one in the file

= Will interpret commands in your default shell
- Set SHELL variable in makefile to ensure

+ Target execution:

" Check each source in the source list:

- If the source is a target in the makefile, then process it recursively
- |f some source does not exist, then error

- If any source is newer than the target (or target does not exist), run
command (presumably to update the target)

36
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“Phony” Targets

+» A make target whose command does not create a file of
the target’s name (i.e., a “recipe”)

= As long as target file doesn’t exist, the command(s) will be
executed because the target must be “remade”

+ e.g., target clean is a convention to remove generated
files to “start over” from just the source

clean:
rm foo.o bar.o baz.o widget *~

+ e.g., target all is a convention to build all “final
products” in the makefile
= Lists all of the “final products” as sources

37
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“all” Example

CSE333, Autumn 2025

qéll: prog B.class somelLib.a—
2 # notice no commands this time

4
prog: foo.o bar.o mailin.o

5 9cc —O prog foo.o0 bar.o main.o

// B.class: B.java
jJavac B.java

somel.ib.a: ,foo.0 baz.o
7
ar r foo.o baz.o

»foo.0: foo.c foo.h headerl.h header2?2.h
gcc —c¢ -Wall foo.c

\# similar targets for bar.o, main.o, baz.o,

etc. ..

J

38
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make Variables

« You can define variables in a makefile:

= All values are strings of text, no “types”
= Variable names are case-sensitive and can’t contain ‘:’, ‘#’, ‘=’, or

whitespace
+» Example: (cc = gec D
CFLAGS = -Wall -std=cl7
OBJFILES = foo.0 bar.o baz.o
widget: S (OBJFILES)
. $(CC) S$(CFLAGS) -o widget S (OBJFILES) )

+» Advantages:
= Easy to change things (especially in multiple commands)
- It’'s common to use variables to hold lists of filenames

" Can also specify/overwrite variables on the command line:
(e.g., make CC=clang CFLAGS=-g) 26
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. . . STYLE
Makefile Writing Tips I
+» When creating a Makefile, first draw the dependencies!!!!

+ CDependency Rules:
= _cand .h filesare never targets, only sources.

= Each . c file will be compiled into a corresponding . o file
- Header files will be implicitly used via #include
= Executables will typically be built from one or more . o file

+» Good Conventions:
" Include a clean rule
= |f you have more than one “final target,” include an al1 rule
= The first/top target should be your singular “final target” or all

40
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Writing a Makefile Example

+« “talk” program (find files on web with lecture slides)

[main.c ] [speak.h] [Speak.c] [shout.h] [shout.c]

speak.c
main.c #include "speak.h"
#include "speak.h"
#include "shout.h" shout.c
#include "speak.h"
int main(int argc, char** argv) {.. #include "shout.h"
41
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Writing a Makefile Example

» “talk” program (find files on web with lecture slides)

shout.h] [shout.c]

~_.

Shout.o]

\: . :/

[ main.c ] [speak.h] [speak.c]

42
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Revenge of the Funny Characters

+ Special variables:
= S@ fortarget name
= S~ forall sources
= S$< forleft-most source

= Lots more! — see the documentation

« Examples: ~

(# CC and CFLAGS defined above
widget: foo.o bar.o

S (CC) $(CFLAGS) -o S@ s©
foo.0: foo.c foo.h bar.h

S(CC) S (CFLAGS) -c s<

43
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And more...

« There are a lot of “built-in” rules — see documentation
» There are “suffix” rules and “pattern” rules

" Example: 3.class: 5. java
javac S< # we need the S$< here

+» Remember that you can put any shell command — even
whole scripts!

» You can repeat target names to add more dependencies

+» Often this stuff is more useful for reading makefiles than
writing your own (until some day...)

44
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Lecture Outline

+ System Calls (High-Level View)
» Make and Build Tools
» Makefile Basics

+ C History (for reading, not covered in lecture)

CSE333, Autumn 2025
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Development of the C Language

+ Created in 1972
"= BCPL->B—>C
= Designed specifically as a system programming language for Unix
- Unix was rewritten entirely in C (Version 4 in 1973)

« “Standardized” in 1978 with release of K&R Ed. 1

" From initial creation, developed
in terms of portability and type safety ORI

« Formal standardization via American National
Standards Institute (ANSI) in 1989 and International
Organziation for Standardization (ISO) in 1990

= Non-portable portion of the Unix C library was the basis for the
POSIX standard via IEEE

PROGRAMMING

47
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Development of the C Language

+ Development Context:

= Developed for the PDP-7/PDP-11
- Very limited memory available for program

" Improvements over B: data typing, performance, byte
addressibility

= Developed in the context of operating system innovations
(Multics, Unix)

- “Particularly oriented towards system programming, are small and
compactly described, and are amenable to translation by simple
compilers.”

- “By design, C provides constructs that map efficiently to typical
machine instructions. It has found lasting use in applications
previously coded in assembly language.”

+» Who used computers and programming at the time?

48



W UNIVERSITY of WASHINGTON LO8: System Call Details & Makefiles CSE333, Autumn 2025

Development of the C Language

+ Credits:
= Dennis Ritchie designed C

= Ken Thompson designed B and, with Ritchie, were the primary
architects of UNIX (in assembly)

= Brian Kernighan helped Ritchie write K&R, the first
“standardization” of the C language

“The development of the C language” (https://dl.acm.org/doi/10.1145/155360.155580)

Ken Dennis Brian
Thompson Ritchie Kernighan 49
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Principles of C

« Some commonly-held contemporary views:

= “Since Cis relatively small, it can be described
in small space and learned quickly.”

= “Shows what’s really happening.”
= “Close to the machine/hardware.”
" “Only the bare essentials.”

" “No one to help you.”

= “You’re on your own.”

= “l know what I’'m doing, get out of my way.”

50
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